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Subj:  RANGE DESIGN MANUAL 
 
1.  PURPOSE.  This Manual contains general guidance for the design of 
    two-station ranges as well as specific instructions on the use of a 
    computer program for the detailed design of two-station ranges. 
 
2.  ACTION.  Area and District Commanders, Commanders of Maintenance and 
    Logistics Commands, Commanding Officers of Civil Engineering Units, 
    Commanding Officers of Headquarters units, Assistant Commandants for 
    Directorates, Chief Counsel, and special staff offices at Headquarters 
    shall ensure that personnel working with ranges use this manual and 
    the computer program in the design and evaluation of ranges. 
 
3.  DIRECTIVES AFFECTED.  COMDTINST M16500.4A, Range Design, is canceled. 
 
4.  DISCUSSION.  The following changes from COMDTINST M16500.4A have been made: 
 
    a.  The computer program is designed to operate on the Coast Guard 
        Standard Workstation III (SWIII) in Microsoft Excel. 
 
    b.  The computer program is available for use by District and CEU 
        personnel for designing new ranges or evaluating existing ones. 
 
    c.  This manual is organized to provide step-by-step instructions for 
        the use of the range design program on the SWIII and to provide 
        practical guidelines for the design of ranges in U.S. waters. 
 
5.  CHANGES.  Recommendations for improvements to this manual or the 
    computer program shall be submitted to Commandant (G-SEC-2). 
 
 
 
 
                                       E. C. KARNIS 
                                       Director of Engineering 
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                       CHAPTER 1  -  INTRODUCTION 
 
A.  Purpose.  The purpose of this publication is to enable a person with 
    little or no familiarity with the fundamentals of range design to make 
    use of the updated range design computer program. 
 
B.  Program Availability.  The computer program is available from 
    Commandant (G-SEC-2) on an IBM 3-1/2 inch 1.44MB floppy disk.  The 
    program is designed to operate on the SWIII terminal in Microsoft 
    Excel. 
 
C.  Special Features.  The new computer program differs from the old range 
    design program in the following ways: 
 
    1.  The new format of the program on Excel is much more user-friendly, 
        and allows the range design variables to be entered in any order. 
 
    2.  The output of the program is immediately displayed.  Changes to 
        any of the variables has an immediate effect on the output. 
 
    3.  The program gives recommended intensities in addition to the 
        minimum and maximum intensities. 
 
    4.  The program evaluates the performance of both existing and proposed 
        optics. 
 
    5.  Dayboard, daytime optic, and nighttime optic range performance is 
        available. 
 
    6.  Lateral Sensitivity is expressed as Cross-Track Factor and lends a 
        more physical feel to the performance of the range. 
 
D.  New advice is provided in Chapter 5 on standard range configurations 
    and practical constraints on the design of ranges.  Addressing these 
    issues will enable the novice designer to produce range designs that 
    perform as expected and can be safely maintained by servicing units 
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              CHAPTER 2  -  RANGE DESIGN DISCUSSION 
 
A.  Definition of a Range.  A range is a pair of lights or marks 
    (dayboards) or both used to mark a line of definite bearing, commonly 
    the centerline of a channel.  Vertical alignment of these lights or 
    marks defines the centerline of a channel.  Range lights are called 
    "leading lights" by IALA because they "lead" a vessel down a channel. 
 
B.  Views of a Range. 
 
    1.  Plan View.  Figure 2-1 shows a plan view of a range and defines some 
        variables. 
 

 
Figure 2-1.  Plan view of a range. 
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    2.  Side View.  Figure 2-2 is a side view of range structures with some 
        additional variables of interest defined. 
 

 
Figure 2-2.  Side view of range structures 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
                                 2-2 



 
    3.  Front View.  Figure 2-3 is a front view of a range with a ship 
        located to the right of the range axis.  It also shows the 
        horizontal and vertical angles created by the lights as viewed by 
        the observer. 
 

 
Figure 2-3.  Front view of a range. 
 
C.  Channel Length.  The preliminary decision in designing a range is to 
    specify the segment of water which the range is to serve.  Generally, 
    it is costly to build a range to serve a long channel.  This results 
    from the requirements that the rear range light be of sufficient 
    height to be clearly visible above the front range light when viewed 
    from the far end of the channel, and that the dayboards are visible 
    from the far end of the channel.  Therefore, the rear tower must be 
    not only taller, but also considerably sturdier in order to support 
    the dayboard in conditions of heavy wind loading.  The use of 
    alternative aids may reduce the overall cost of marking the waterway 
    by reducing the portion of the channel marked by the range. 
 
D.  Off Axis Distance.  The off axis distance is the perpendicular 
    distance from the range's centerline at which the observer will detect 
    with certainty that the range lights are no longer vertically aligned 
    (Figure 2-4).  This distance must leave sufficient room for the 
    various "nautical margins" needed to navigate the channel with safety. 
    These margins result from such factors as the width of ships 
    navigating the channel, the amplitude of possible yaws of those ships, 
    extra widths required for vessels to pass each other, the angle 
    between the range bearing and the head of the ship when it is affected 
    by cross winds and currents, and other factors relating to the 
    maneuverability of the ship. 
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Figure 2-4.  Off axis distance of a range. 
 
E.  Lateral Sensitivity, The Cross-Track Factor. 
 
    1.  Cross-Track Factor.  The cross-track factor is defined to be the 
        lateral distance at which a mariner can detect with certainty that 
        a vessel is not on the channel centerline, divided by half the 
        channel width, and expressed as a percentage.  A cross-track 
        factor of 25% indicates that a mariner may be as far as 25% of the 
        way towards the edge of the channel when he can detect, with 
        certainty, that he is off centerline.  When using cross-track 
        factor as an expression of lateral sensitivity, a higher 
        cross-track factor implies a lower sensitivity, and vice versa. 
 
    2.  Current Policy on Acceptable Cross-Track Factors.  Table 2-1 
        provides guidelines on the description and acceptability of 
        various cross-track factors. 
 
    3.  Instead of setting upper (%) limits on the cross-track factor, it 
        is present policy that the designer weigh the nautical margins 
        available against the fear that passing vessels will be overly 
        confined (a small (%) cross-track factor may result in increased 
        risk of collision between passing vessels). 
 
        a.  If the cross-track factor at the far end is adequate, chances 
            are good that the cross-track factor at the near end is much 
            smaller.  If there are marks at the turning point at the near 
            end, they will allow the mariner to judge the edge of the 
            channel, and the small cross-track factor may be of no concern. 
 
        b.  When a small cross track factor is a problem, the range design 
            can be modified to have an identical cross-track factor at the 
            far end, but the cross-track factor at the near end will not 
            be as small.  Figure 2-5 illustrates the situation where the 
            cross-track factor at the far end is identical, but the 
            cross-track factor at the near end varies with the two 
            designs.  By moving the range structures back from the near 
            end of the channel and increasing M and R, the cross-track 
            factor at the near end is increased while keeping the 
            cross-track factor at the far end the same. 
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Table 2-1 
 
Cross-Track Factor* 
                                                                     
  Values of 
Cross-Track   Description     Interpretation 
     Factor 
                                                                     
Over 75%      Not Acceptable  Range must be improved or it will be unworkable. 
50% - 75%     Poor            Decrease the cross-track factor if physically 
                              possible. 
30% - 50%     Fair            Decrease the cross-track factor only if 
                              moderate cost involved. 
20% - 30%     Good            Decrease the cross-track factor only if little 
                              cost involved. 
15% - 20%     Very Good       Do not expend more funds to decrease the cross- 
                              track factor. 
10% - 15%     Excellent       The cross-track factor should not be less than 
                              10% at the far end of the channel. 
*Use this table using the cross-track factor 1354at the far end of the channel. 
 

 
Figure 2-5.  Two range designs having the same cross-track factor at the far 
end but different cross-track factors at the near end. 
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    4.  Range Design Selection.  Usually the range shown on the bottom of 
        Figure 2-5 will give better service because the cross-track factor 
        does not vary as much between the near and far ends, and the 
        illuminance produced by each light on the eye of the user will be 
        more nearly equal along the entire length of the channel.  On the 
        other hand this design might require larger dayboards, taller 
        towers, or lights of increased intensity.  It is up to the range 
        designer to select the design that is most appropriate for the 
        given situation. 
 
F.  Beam Width of Range Lights. 
 

 
    2.  The need for acquisition of the range lights prior to turning onto 
        a range should also be considered when selecting the beam width of 
        the range lights.  In order to reach the first useful segment of 
        the range it will often be necessary to observe at least one of 
        the range lights in a region to seaward or to the side of it. 
        This is called the "acquisition region."  The selected range 
        lights should have a beam width sufficient to cover the desired 
        acquisition point. 
 

 
Figure 2-6.  Spread Lens Angles. 
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G.  Dayboards or Daytime Lights.  Traditionally the lights on ranges, 
    particularly those powered by batteries, were secured during daylight. 
    The daytime signal was provided by dayboards.  Recent efficiency 
    improvements in optics combined with solar power have allowed expanded 
    use of daytime lighted ranges, even when commercial power is not 
    readily available.  The following are some points to consider when 
    deciding on the daytime signal: 
 
    1.  Dayboards are simple.  Having no moving parts they require little 
        maintenance and so are more reliable than lights.  The smaller 
        boards are easy to maintain.  No special training is required. 
 
    2.  Daytime lights provide a superior signal.  In marginal conditions 
        they can be seen further than dayboards.  Substituting lights for 
        large dayboards may result in less costly tower structures and 
        foundations.  There will, however, be more complex lighting and 
        power systems which will increase the technical demands on our 
        Aids to Navigation Team personnel.  There will also be higher 
        initial equipment cost, but tower costs will be lower due to 
        smaller towers. 
 
    3.  The Range Category Selection Aid (Enclosure (1)) contains a 
        decision guide and range category descriptions to assist in 
        determining the type of range to provide.  Area and District 
        personnel shall also consider the following when a WAMS analysis 
        establishes the need to construct a new range or replace an 
        existing range: 
 
        a.  Dayboards are not necessary when daytime lights are provided. 
 
        b.  Distances less than 2 nautical miles, as measured from the 
            rear structure to the far end of the channel, are usually best 
            marked by dayboards.  The nighttime signal can usually be 
            provided with standard omnidirectional lanterns and associated 
            equipment.  Daytime range lights should only be considered in 
            areas prone to poor meteorological visibilities. 
 
        c.  Distances greater than 4 nautical miles are best marked by 
            daytime range lights provided there is an operational 
            requirement to mark the entire channel. 
 
            (1)  The existence of a long channel does not in itself 
                 justify the need to mark the entire channel with a range. 
 
            (2)  Daytime lights may not mark the entire channel in lower 
                 visibility conditions, but they will still exceed range 
                 dayboard capabilities. 
 
            (3)  A range light controller may be required on long reaches 
                 because of the significant differences in intensities 
                 required to provide both day and night signals.  Should 
                 the lights on both structures fail to switch in a short 
                 time the range would effectively be unusable since the 
                 daytime light would 
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                 overpower the nighttime light.  The 
                 Range Category Selection Aid (Enclosure (1)) contains 
                 criteria for using range light controllers. 
 
        d.  Distances between 2 and 4 nautical miles should be marked as 
            operationally required or as economically as possible.  It may 
            be that a lighted daytime range is not required but the system 
            lifecycle cost of a lighted range might be lower than using 
            dayboards. 
 
        e.  Projects to establish daytime range lights shall be forwarded 
            to Commandant (G-OPN-2) for operational approval.  Commandant 
            (G-SEC-2) will provide input for range design and equipment 
            selection.  Enclosure (2) presents block diagrams of signal, 
            power, and control systems for each of the eight established 
            USCG standard range configurations. 
 
H.  Considerations Regarding Intensities. 
 
    1.  Nighttime lights should be of sufficient intensity to mark the 
        entire channel length for 90% of the nights.  The "Minimum 
        Intensity" values provided by the program will provide adequate 
        signals; however, higher intensities will provide better signals. 
        Experience has shown that intensity values ten times greater than 
        the minimum values will provide a better signal.  Therefore, the 
        program provides a "Recommended Intensity" that is approximately 
        ten times the Minimum Intensity and provides a good illuminance 
        balance.  It is often easy to provide the Recommended Intensities 
        and therefore provide not just an adequate, but a good signal. 
 
    2.  Daytime lights should be of sufficient intensity to maximize the 
        percentage of time that the channel is adequately marked.  If you 
        can meet the "Minimum Intensity" you do not need to go beyond that 
        intensity.  If you can't meet the "Minimum Intensity" put in the 
        brightest light possible. 
 
I.  Standard Range Characteristics. 
 
    1.  Standard light characteristics for ranges are: 
        Front                           Rear 
        Fixed (F) *                     Fixed (F) * 
        Occulting 4 (Occ 4) *           Occulting 4 (Occ 4) * 
        Isophase 6 (Iso 6)              Isophase 6 (Iso 6) 
        Isophase 2 (Iso 2) 
        Flashing 2.5 (1) (Fl 2.5 (1)) 
        Quick Flash (Q) w 
 
        Notes:  * Not recommended for solar power applications. 
                w Only for lamps rated for 2.03a and less. 
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    2.  Fixed (F) characteristics should be used sparingly, if at all. 
        Lights displaying a fixed characteristic, especially white light 
        signals can be difficult to identify against even minimal 
        background lighting.  Furthermore, lights displaying an Occ 4 or 
        Iso 6 characteristic provide approximately 92% of the intensity of 
        a fixed light signal, yield longer lamp service intervals, have 
        lower power consumption, and provide greater conspicuity than the 
        fixed light signal. 
 
J.  Visibility Values. 
 
    1.  In 1988, the U.S. Coast Guard Research and Development Center 
        studied several years of National Weather Service coastal 
        visibility data in order to update the values of visibility used 
        for aid-to-navigation planning along the coastal U.S. and Great 
        Lakes.  The tables in Enclosure (3) provide these updated values 
        for 80 and 90 percent of the time. 
 
    2.  The tables, in order, are for Alaska, Hawaii, West Coast, Great 
        Lakes, East Coast, and Florida & Gulf Coasts.  The values are 
        presented in one-degree grids for each of these regions.  To find 
        the visibility value, enter the appropriate table using the whole 
        number degree (rounded down) of latitude and longitude for the 
        position of the aid.  For example, for an aid located at 39 20.9' 
        N & 123  49.6' W, enter the table at LAT = 39 & LONG = 123.  Note, 
        the values provided in the tables are based on averaging the data 
        collected within each one-degree grid over a 30 year period.  The 
        values are valid for all sections of the one-degree grid. 
        Therefore, interpolation between adjacent grids should not be 
        performed. 
 
    3.  The values from these tables are entered in the program as Minimum 
        Visibility (nm). 
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                      CHAPTER 3 - PROGRAM OPERATION 
 
A.  System Requirements.  You need a Coast Guard Standard Workstation III 
    or an IBM PC computer system with Windows 3.1 or later and Microsoft 
    Excel 3.0 or later. 
 
B.  Running the Program.  Turn on your computer.  If you have the range 
    design program on a floppy disk insert it into the computer and copy 
    the file onto your hard disk.  Remove the floppy disk and store it in 
    a safe place.  Do not do any work on the floppy disk, this is the 
    master copy.  Open your Microsoft Excel program.  Under the Tools menu 
    move down and select the Options... command.  Select the Edit tab and 
    uncheck (disable) the Enable AutoComplete for Cell Values option. 
    Then click on the OK button.  Next at the top left of the screen click 
    the File menu and move down to the Open... command.  Select the range 
    design program (which should be on your hard drive) and open it.  DO 
    NOT ATTEMPT TO ALTER THE PROGRAM IN ANY WAY. 
 
C.  On-Screen Display for SWIII.  In order to see the entire range design 
    spreadsheet on the SWIII computer screen there are several options. 
    Under the View menu select (check mark) the Full Screen mmand.  If  co
    you still can't see the whole spread sheet, under the View menu select 
    the Toolbars... command and make sure all the toolbars are deselected. 
    Finally if you still can't see the whole spread sheet, under the View 
    menu select the Zoom... command and check Custom Magnification and 
    enter 63%.  For PCs which are not SWIII use trial and error to find a 
    magnification number which allows the entire spreadsheet to be viewed 
    on the display.  Contact G-SEC-2A for additional support. 
 
D.  Input Data.  You can enter any of the range parameters at any time, 
    however when first starting out it is best to enter the data in order. 
    Enclosure (4) provides a sample of a range design input screen.  Data 
    is entered in any input cell that appears shaded (using Windows 
    default colors) and outlined with a box.  All input cells require data 
    unless otherwise indicated.  If any required input cells are left 
    empty the Cross Track Factor, Off Axis Distance, and Delta will not be 
    computed correctly. 
 
    1.  Range Name - Enter the name of the range. 
 
    2.  Night or Day Lights - Enter either an "N" for nighttime range 
        lights or a "D" for daytime range lights (Note, separate runs are 
        required for ranges using daytime and nighttime lights). 
 
    3.  Length of Channel (C) - Enter the length of the channel in feet. 
 
    4.  Width of Channel (W) - Enter the width of the channel in feet. 
 
    5.  Mean Range of Tide (MRT) - Enter the mean range of the tides in 
        feet.  It is the difference between mean high water and mean low 
        water for the design area. 
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    6.  Background Lighting - Enter the amount of background lighting 
        that is present, either "None," "Minor," or "Considerable."  Minor 
        background lighting refers to widely spaced lights and/or dim 
        lights such as residential lighting.  Considerable background 
        lighting refers to numerous lights and/or very bright lights such 
        as parking lots, highways, factories, and industrial lighting that 
        compete with the intensity of the range lights. 
 
    7.  Height of Eye (HOE) - Enter the height of eye of one to three 
        observers above the water in feet.  The HOE is located in the 
        center of the spreadsheet in 3 places. 
 
    8.  Minimum Visibility - Enter the minimum visibility for which the 
        range is designed in nautical miles.  Generally it is the 
        visibility that occurs 90% of the time for the location of the 
        range.  Enclosure (3) provides tables of visibility data for the 
        coastal U.S. and the Great Lakes.  Use the LAT and LONG of the 
        ranges, round down to a whole degree, and find the corresponding 
        visibility in Enclosure (3). 
 
    9.  Design Visibility - Enter the design visibility in nautical 
        miles.  A value of 10nm is recommended. 
 
   10.  Maximum Visibility - Enter the maximum visibility for which the 
        range is designed in nautical miles.  For practical 
        considerations, a value of 20nm is recommended. 
 
   11.  Distance Between RFL & RRL (R) - Enter the distance between the 
        range structures in feet. 
 
   12.  Distance RFL to Near End Channel (M) - Enter the distance from 
        the near end of the channel to the front range structure in feet. 
 
   13.  Safe Height Above Water (SAFHW) - Enter the safe height of the 
        range above water in feet.  It is the minimum distance required to 
        keep the front dayboard/optic from being damaged by wave action, 
        spring tides, or vandals. 
 
   14.  Dayboards To Be Used - Enter a "Y" to use dayboards or an "N" for 
        no dayboards. 
 
   15.  Obstructions - Enter the distance from the near end of the 
        channel to the obstruction(s) in feet, and the height of the 
        obstruction(s) in feet. 
 
   16.  RFL Selected Dayboard Length - Enter the length of the front 
        dayboard in feet.  Ignore this block if not using dayboards or 
        enter "None". 
 
   17.  RRL Selected Dayboard Length - Enter the length of  the rear 
        dayboard in feet. Ignore this block if not using dayboards or 
        enter "None" 
 
   18.  RFL Selected Intensity - Enter the intensity of the front range 
        light that most closely meets the Recommended Intensity taking 
        into account the color, rhythm, and 
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        spread lens (see section "F" for more details).  If there is more 
        than one optic simply multiply the intensity by the number of optics. 
 
   19.  RRL Selected Intensity - Enter the intensity of the rear range 
        light that most closely meets the Recommended Intensity taking 
        into account the color, rhythm, and spread lens (see section "F" 
        for more details).  If there is more than one optic simply 
        multiply the intensity by the number of optics. 
 
   20.  Selected Height RFL - Enter the height of the focal plane of the 
        front optic in feet from MHW.  Use separate heights for day and 
        night lights (see Chapter 5 for more details). 
 
   21.  Selected Height RRL - Enter the height of the focal plane of the 
        rear optic in feet from MHW.  Use separate heights for day and 
        night lights (see Chapter 5 for more details). 
 
The following variables are not necessary to run the program, but are valuable  
simply for the information they contain: 
 
   22.  (# of) Optics - Enter the number of optics and type of optic used. 
        For example:  (2) RL-14, (1) RL-24, (1) 250mm, etc. 
 
   23.  Lamp - Enter the type of lamp used in the optic.  For example: 
        0.77a, 2.03a, 50w, 1000w, etc. 
 
   24.  Lens / Color - Enter the type of lens used and the color.  For 
        example:  0 deg / Clear, 8 deg / Red, CP / Green, etc. (CP = 
        condensing panel) 
 
   25.  Characteristic - Enter the flash characteristic and color.  For  
        example: Iso 2 W, Fl 2.5 (1) R, Occ 4 G, F W, etc. 
 
E.  Output Data.  A sample of the output data is included as enclosure 
 
    (5).  The output data is immediately computed upon entering any 
    variable.  The output can be sent to a printer or saved under a 
    different file name.  It is best to save daytime and nighttime 
    calculations under different filenames to avoid confusion. 
    Explanations of the outputs: 
 
    1.  Recommended Dayboard Length - The recommended length of the 
        dayboard in feet for the given minimum visibility. 
 
    2.  Minimum Intensity - The minimum intensity (in candela) required 
        to ensure the range light is useable at the far end of the channel 
        for the given minimum visibility. For daytime lighted ranges the 
        program only provides values for the minimum required intensities. 
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    3.  Recommended Intensity - The recommended intensity (in candela) 
        to assist the mariner in detecting, recognizing, and using the 
        range lights.  This value is approximately ten times the minimum 
        intensity and takes into account illuminance balance. 
 
    4.  Maximum Intensity - The maximum intensity (in candela) allowable 
        for the range light, to prevent glare for the given maximum 
        visibility. 
 
    5.  Recommended IR/IF -  The recommended intensity ratio for the 
        rear and front optics where: 
 
                            Recommended Rear Light Intensity 
                 IR/IF =                                        
                            Recommended Front Light Intensity 
 
    6.  IR/IF for Selected Intensities - The intensity ratio for the 
        selected optics. 
 
    7.  Recommended Min Height - The recommended focal plane height of the 
        optic. 
 
    8.  Distance from Near End - The distance of the observer from the 
        near end of the channel at ten evenly spaced intervals along the 
        entire length of the channel. 
 
    9.  Cross-Track Factor - The cross-track factor at the indicated 
        distance from the near end of the channel. 
 
   10.  Off Axis Distance - The distance perpendicular to the range axis 
        (in feet) needed to indicate to the observer that they are off the 
        range axis, at the indicated distance from the near end of the 
        channel. 
 
   11.  Delta (mrad) (MLW) - The apparent vertical angle subtended by 
        the range lights (vertical angle separation) in milliradians, at 
        the indicated distance from the near end of the channel. 
 
   12.  Illuminance Ratios & Values - Provides information on the 
        apparent brightness of the two range optics for the selected 
        design visibility, at the indicated distance from the near end of 
        the channel. 
 
   13.  Problem Codes - Chapter 4 discusses Problem Codes and Dayboard 
        Problem Codes which may appear on the range design output sheet. 
        The sample sheet provided as enclosure (5) shows all the potential 
        problem codes for informational purposes 
 
F.  Printing the Spreadsheet.  For the program to print properly go to the 
    File menu and select the Page Setup... command.  Under the Page tab 
    change the Orientation to Landscape and ensure the Scaling is Adjusted 
    to 70%.  Also ensure that under the Margins tab all the margins 
    (including the header and footer) are set to 0.25 inches.  And make 
    sure that in Center on Page both Horizontally and Vertically are 
    checked.  Do not adjust any other parameters. 
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    Now you are ready to print by either clicking on the Print icon on the 
    tool bar, or under the File menu selecting the Print... command. 
    Enclosure (5) provides a sample range design printout. 
 
G.  Single-Point-in-Time Performance Run.  To see how the range will 
    perform on a given day with a given visibility enter the same 
    visibility for Minimum, Design, and Maximum Visibility.  The output is 
    a snapshot of how the range will perform for that given visibility. 
 
H.  Range Light Signal Selection. 
 
    1.  Use the Range Design Program to determine the recommended 
        intensities for the front and rear range optics. 
 
    2.  Use the Range Category Selection Aid (Enclosure (1)) and the Range 
        Light Signal Performance Data (Enclosure (4)) to identify which 
        optics will give acceptable intensities. 
 
    3.  Select the combination of lantern, lens (color/spread), lamp 
        (12-VDC or 120-VAC), and rhythm which best meets the desired 
        intensities, and which has adequate beamwidths to cover the 
        required region (see Chapter 2, Section "F").  When possible, use 
        of omnidirectional lanterns is highly desirable, as the signal can 
        be acquired even when vessels are well off the channel centerline. 
        The use of omnidirectional lanterns also precludes the 
        requirement for passing lights on range towers in navigable 
        waters.  Refer to Chapter 5 for advice on the practical details of 
        tower placement, multiple beacon mounting schemes, and aid 
        maintainability. 
 
    4.  A 50 watt and higher 12VDC lamp requires a high-wattage 
        lampchanger and a high-wattage flasher (CG-481). 
 
    5.  If more than two lanterns are needed on a single range for daytime 
        use, the design should be discussed with G-SEC-2 staff prior to 
        submission to consider alternate methods of marking the waterway 
        with standard configurations. 
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                    CHAPTER 4 - TROUBLE SHOOTING 
 

 
 
Figure 4-1.  Range Diagram. 
 
A.  Problem Codes.  Below is a list of the possible problem codes that may 
    be displayed while running the range design program. 
 
    1.  Lights will blur.  
    2.  Cross Track Factor too big.  
    3.  RFL not bright enough in min visibility.  
    4.  RRL not bright enough in min visibility.  
    5.  RFL exceeds glare limit in max visibility.  
    6.  RRL exceeds glare limit in max visibility.  
    7.  RFL Dayboard too small in min visibility.  
    8.  RRL Dayboard too small in min visibility.  
    9.  RRL appears lower than RFL.  
    10. RFL below Safe Height Above Water.  
    11. RFL below the horizon.  
    12. Obstruction #1 obstructs RFL.  
    13. Obstruction #1 obstructs RRL.  
    14. Obstruction #2 obstructs RFL.  
    15. Obstruction #2 obstructs RRL.  
 
B.  Dayboard Problem Codes.  Below is a list of the possible dayboard 
    problem codes that may be displayed while running the range design 
    program. 
 
    1.  Portion of RFL board below horizon.  
    2.  RFL board below Safe Ht Above Water.  
    3.  RFL obscures part of RRL board.  
    4.  RFL obstructs more than 1/2 RRL board.  
    5.  Obstruction #1 obstructs RFL dayboard.  
    6.  Obstruction #1 obstructs RRL dayboard.  
    7.  Obstruction #2 obstructs RFL dayboard.  
    8.  Obstruction #2 obstructs RRL dayboard.  
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Figure 4-2.  Range Diagram. 
 
C.  Problems and Fixes.  Here are some problems with suggested fixes and 
    possible downsides to the fixes.  Common problem codes are grouped 
 
 
   together. 

PROBLEM CODES:  
 
    Problem                  Possible Fix           Downside 
1.  Lights will blur.       Raise RRL.              Extra cost; decreased 
                                                      sensitivities. 
                              Reduce intensities.     Lights harder to acquire 
                                                      & use. 
                              Lower RFL.              Closer to water. 
                              Decrease C.             May not meet users 
                                                      requirements. 
__________________________________________________________________________ 
2.  Cross Track Factor      Increase R.             May need real estate; 
    too big.                                         extra cost; will increase 
                                                      RRL height. 
                              Increase RFL height     Lights may blur. 
                              or decrease RRL height. 
__________________________________________________________________________ 
3,  RFL (RRL) not bright    Increase intensity.     May cause glare/blur; 
                                                      extra cost. 
4.  enough in min visibility.  
__________________________________________________________________________ 
5,  RFL (RRL) exceeds glare Reduce intensity.       Light harder to acquire 
                                                      & use. 
6.  limit in max visibility.  
                              Increase M.             May need real estate; 
                                                      extra cost. 
__________________________________________________________________________ 
7,  RFL (RRL) dayboard too  Increase dayboard size. Extra cost. 
8.  small in min visibility.  
                              Use daytime lights.     Extra initial equipment 
                                                      cost 
_________________________________________________________________________ 
 
 
 
 
 
                                 4-2 



 
 

 
Figure 4-3.  Range Diagram. 
 
    Problem                  Possible Fix           Downside 
 
9.  RRL appears lower       Lower RFL.              Lights/dayboard closer to 
    than RFL.                                        water. 
                              Raise RRL.              Extra cost; decreased 
                                                      sensitivities. 
                              Decrease R.             Decreased sensitivities 
__________________________________________________________________________ 
10. RFL below Safe          Raise RFL.              May cause blur; raise RRL. 
    Height Above Water.  
                              Use smaller dayboard.   May not be adequate. 
__________________________________________________________________________ 
11. RFL Below Horizon.      Raise RFL.              May cause blur; raise RRL 
                              Decrease M.             May cause glare; harder to 
                                                      balance illumination 
                                                      ratios. 
__________________________________________________________________________ 
12, Obstruction #1, 2       Raise RFL.              May cause blur; raise RRL 
13. obstructs RFL.  
                              Remove obstruction.     May not be legal/possible. 
                              Decrease M.             May cause glare; harder to 
                                                      balance illumination 
ratios. 
__________________________________________________________________________ 
14, Obstruction #1, 2      Raise RRL.              Decreased sensitivities; 
15. obstructs RRL.                                  extra cost. 
                              Remove obstruction.     May not be legal/possible. 
                              Decrease R.             Decreased sensitivities 
__________________________________________________________________________ 
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Figure 4-4.  Range Diagram. 
 
DAYBOARD PROBLEM CODES:  
 
    Problem                  Possible Fix           Downside 
1.  Portion of RFL board    Raise RFL dayboard.     Extra cost. 
    below horizon.  
                              Decrease M.             May cause glare; harder to 
                                                      balance illumination 
                                                      ratios. 
                              Use daytime lights.     Extra initial equipment 
                                                      cost. 
__________________________________________________________________________ 
2.  RFL board below Safe    Raise RFL dayboard.     Extra cost. 
    Ht Above Water.  
                              Use daytime lights.     Extra initial equipment 
                                                      cost. 
__________________________________________________________________________ 
3.  RFL obscures part of    Lower RFL dayboard.     Closer to water, decreased 
    RRL board.                                      sensitivities. 
                              Raise RRL dayboard.     Extra cost, decreased 
                                                      sensitivities. 
                              Use daytime lights.     Extra initial equipment 
                                                      cost. 
__________________________________________________________________________ 
4.  RFL obstructs more      Lower RFL dayboard.     Closer to water, decreased 
    than 1/2 RRL board.                             sensitivities. 
                              Raise RRL dayboard.     Extra cost, decreased 
                                                      sensitivities. 
                              Use daytime lights.     Extra initial equipment 
                                                      cost 
_________________________________________________________________________ 
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Figure 4-5.  Range Diagram. 
 
    Problem                 Possible Fix            Downside 
 
5,  Obstruction #1, 2     Raise RFL.                May cause blur; raise RRL 
7.  obstructs RFL dayboard.  
                            Remove obstruction.       May not be legal/possible. 
                            Decrease M.               May cause glare; harder to 
                                                      balance illumination 
ratios. 
__________________________________________________________________________ 
6,  Obstruction #1, 2 aise RRL.                Decreased sensitivities;      R
8.  obstructs RRL dayboard.                         extra cost. 
                            Remove obstruction.       May not be legal/possible. 
                            Decrease R.               Decreased sensitivities. 
__________________________________________________________________________ 
 
D.  When the Maximum Intensity is less than the Recommended / Minimum 
    Intensity.  If you encounter this situation it means the RFL (and 
    maybe the RRL) is too close to the channel and is blinding the 
    vessels.  There are two solutions.  The first is to move the RFL (and 
    maybe the RRL) back from the channel to increase M.  The second is to 
    not move the ranges and chose an intensity that is between the Minimum 
    and Maximum Intensities and live with the glare at the near end of the 
    channel. 
 
E.  Range Design is an Art.  There is no single correct range design for a 
    given channel.  There can be multiple successful combinations of 
    optics, lamps, range structure locations, optic heights, flash 
    characteristics, colors, etc.  After creating a few ranges, the 
    designer starts to get a feel for what can and cannot work.  It is a 
    trial and error process. 
 
F.  Compromise During Range Design.  With all the different types of range 
    designs possible for a given channel, there comes a point where the 
    designer must select which range design to use.  Some of the selection 
    criteria can be cost of construction, maintenance, cross-track factor, 
    off axis distance, minimized tower heights, power requirements, HOE of 
    primary user, and user input.  This is just a partial list, but one 
    can see that much more goes into range design than just the design 
    itself. 
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          CHAPTER 5 - RANGE CONFIGURATIONS & DESIGN CONSTRAINTS 
 
A.  Introduction.  This chapter establishes configurations and design 
    constraints of ranges.  These items must be considered when designing 
    and building the support structures housing the optics to ensure that 
    performance of the aid will be as predicted and that personnel can 
    safely service it.  The review and approval process is illustrated in 
    COMDTINST M16500.8A, Automation Technical Guidelines, Figure 1-20 
    (Project Documentation Approval Process). 
 
B.  Tower Placement.  Placement of the range towers determines the range 
    centerline.  Tower placement along the centerline shall be within 10 
    feet of the desired position, as shown in Figure 5-1.  The lateral 
    error caused by placement of the towers on either side of the true 
    centerline, shall be limited to one foot.  See Figure 5-1. 
 

 
Figure 5-1.  Tower Placement. 
C.  Beacon Placement.  Proper beacon placement is necessary to ensure that 
    blur will not occur during nighttime hours, and that each light or 
    group of lights will be viewed as a single source.  The heights listed 
    in the range design program are the heights from mean high water to 
    the centerline of the optics.  For day & night lighted ranges, the 
    lower optic on the front tower and the upper optic on the rear tower 
    shall be the nighttime lights.  Vertical separation shall be 3 feet. 
    The only exception to this is if the front tower has an 
    omnidirectional nighttime light which shall be mounted above the 
    daytime lights.  Multiple optics for daytime lights shall be installed 
    on a horizontal plane not to exceed three across.  Horizontal 
    separation shall be kept to a minimum to be sure the lights are viewed 
    as a point source.  Figure 5-2 details some common configurations of 
    day/night optics 
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Figure 5-2.  Day/Night Range Configurations 
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D.  Additional Lights.  If the range design is NOT using omnidirectional 
    optics at night it may be necessary to add additional omnidirectional 
    lights.  Additional lights should be mounted where it will not be 
    blocked by the range structure. 
 
    1.  The standard convention is to mount additional light(s) at a 
        height of 40' or lower to ensure that it will be visible to small 
        boats with a low HOE.  As an example, if a lighted range has a RFL 
        height of 25', a RRL height of 80', the additional light for the 
        RFL can be mounted above the RFL range lights (both day and 
        night).  However, the additional light should be synchronized with 
        the RFL flash characteristic using a slave flasher.  The 
        additional light should also be the same color as the RFL.  Power 
        for the additional light should come from the RFL power source. 
 
    2.  The additional lights for the 80' RRL are actually passing lights 
        and should be mounted lower than the range optic to be seen by a 
        small boater.  Since the RRL structure will partially block the 
        passing light, two passing lights will be required. The passing 
        lights should be mounted on opposite corners of the structure. 
        They must be synchronized with each other using a master and slave 
        flasher.  It is recommended that power for the two passing lights 
        come from a separate source than that of the RRL optic. 
 
    An added benefit to using additional/passing lights is early acquisition 
    of the tower in the near end when piloting out-bound on the range. 
 
E.  Servicing Considerations.  Range towers shall be designed to ensure 
    that they can be serviced safely.  Since most range lights are 
    serviced from the front, at least 2-1/2 feet of deck space is required 
    to safely work on lanterns and solar panels.  Additionally, lanterns 
    shall be elevated a minimum of 18 inches off the deck and any lantern 
    installed above 48 inches shall have a work platform built into the 
    structure to allow personnel to stand while servicing.  RL-14 lanterns 
    open upwards and require clear space above to allow the door to swing 
    open, as shown in Figure 5-3.  RL-24 lanterns have a conventional, 
    side mount hinge.  Railings shall be installed, where appropriate, 
    with either careful placement to prevent obstruction of the light or 
    removable safety chains in front of optics.  Operation and maintenance 
    guides, if prepared, should be passed to the District who would pass 
    it on to the assigned servicing unit. 
 
F.  Construction Details.  Boat landings shall be oriented so that 
    boarding can be easily made during prevailing current and wind 
    conditions.  Boarding ladders shall have rail extensions to allow easy 
    transition from the deck to the ladder.  For range lights in excess of 
    60 feet from the deck or ground to the servicing platform, the 
    designer should consider utilizing a stairway instead of a ladder. 
    All-weather, hand operated winches, with covers shall be installed on 
    the main deck containing power system equipment and on the lantern 
    deck to facilitate easy handling of hardware.  Solar panels shall be 
    installed so that access to both sides of the array are possible and 
    shall not be shadowed by railings, antennas, towers, shelters, etc., 
    within an arc of +/- 90 degrees of the panel's orientation 
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G.  Safety.  Installations using large Exide or other lead-acid batteries 
    shall have safety covers on intercell connectors to protect from 
    accidental shorting.  Battery rooms should have servicing equipment 
    (hydrometer, tarp for covering solar panel, etc.) and safety equipment 
    (eye wash station, gloves, goggles, etc.) available to servicing 
    personnel in the event they don't bring them. 
 

 
Figure 5-3.  Servicing Consideration 
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H.  Dayboards.  Dayboard mountings on structures shall be strong enough to 
    secure the dayboard up to the tower's designed wind load and allow 
    servicing personnel easy replacement.  However, the dayboard mountings 
    should not exceed the tower strength (dayboard mountings should fail 
    before the structure does).  Access to the dayboard by ladder or 
    platform is necessary to remove/replace fasteners.  Use of day/night 
    lights is encouraged on ranges requiring 16 and 24 foot dayboards as 
    these are the most hazardous to replace. 
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RANGE CATEGORY SELECTION AID 
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Encl. (1) to COMDTINST M16500.4B 
 
                       RANGE CATEGORY SELECTION AID NOTES 
 
    1.  There are factors to consider when deciding whether or not to use 
        daytime lights.  Using the Excel Range Design Program, design the 
        range using dayboards, then redesign the range using daytime 
        lights.  Compare performance characteristics and associated costs 
        of each approach to make the final judgment. 
 
    2.  Like most aspects of range design, choosing between a single 
        intensity, 24-hour signal or a dual intensity, day/night signal 
        for solar applications involves tradeoffs: 
 
        a.  Factors that favor a single intensity light include: 
            Fewer optics (to buy and service). 
            No need for day/night control switching. 
            Brighter night light usually a superior signal. 
            Simpler system. 
 
        b.  Factors that favor a brighter day light and a dimmer night light: 
            Requires fewer solar panels than brighter 24-hour light. 
            Requires less battery capacity than brighter 24-hour light. 
            Dimmer night light will tend to lower required height of RRL. 
 
    3.  The Range Light Controller (RLC) is an EECEN-developed, 
        microprocessor-based device to synchronize switching of front 
        and rear lights from day to night signals simultaneously. Its 
        use is recommended when day and night light intensities differ 
        by 50 times or more, such that the range is not useable in the 
        short period when both front and rear lights are not in the 
        same day or night mode. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
                                 2 



                                            Encl. (2) to COMDTINST M16500.4B 
 
Standard Range Equipment Configurations 
 
SOLAR-NIGHT (ONLY) RANGE (Category S-N)  
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Standard Range Equipment Configurations 
 
SOLAR-NIGHT (ONLY) RANGE (Category S-N)  
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Standard Range Equipment Configurations 
 
COMMERCIAL-24 HOUR RANGE (Category C-24)  
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RANGE DESIGN WORKSHEET 
 
Range Name: ______________________________ Light List # ____________________ 
 
Location of Range: _____________________________ Chart # ___________________ 
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RANGE DESIGN WORKSHEET 
 
1.   Night or Day Lights:  (N or D)                        _______________ 
 
2.   Length of Channel (C):                             _______________ ft 
 
3.   Width of Channel (W):                              _______________ ft 
 
4.   Mean Range of Tide (MRT):                          _______________ ft 
 
5.   Background Lighting: (None, Minor, Considerable)      _______________ 
 
6.   Height of Eye of Observer:                         _______________ ft 
                                                             _______________ ft 
                                                             _______________ ft 
 
7.   Minimum Visibility:                                _______________ nm 
 
8.   Design Visibility:                                 _______________ nm 
 
9.   Maximum Visibility:                                _______________ nm 
 
10.  Distance Between RFL & RRL (R):                    _______________ ft 
 
11.  Distance RFL to Near End Channel (M):              _______________ ft 
 
12.  Safe Height Above Water (SAFHW):                   _______________ ft 
 
13.  Dayboards To Be Used: (Y or N)                        _______________ 
 
14.  Obstructions:  
     Location:  (distance from near end of channel)         Height:  
     ________________                                        _______________ ft 
     ________________                                        _______________ ft 
 
15.  RFL Dayboard Length:                               _______________ ft 
 
16.  RRL Dayboard Length:                               _______________ ft 
 
17.  RFL Intensity:                                     _______________ cd 
 
18.  RRL Intensity:                                     _______________ cd 
 
19.  Height RFL:                                        _______________ ft 
 
20.  Height RRL:                                        _______________ ft 
 
21.  (# of) Optics:  ______________   _______________ 
 
22.  Lamp:           ______________   _______________ 
 
23.  Lens / Color:   ______________   _______________ 
 
24.  Characteristic: ______________   _______________ 
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